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Important Safety Information

WARNING: Never look into the projector lens when the lamp is turned on; the bright light can damage your eyes.
Never let children look into the lens when it is on. Never open any cover on the projector, except the lamp and
filter covers. Dangerous electrical voltages inside the projector can severely injure you. Except as specifically
explained in this User's Guide, do not attempt to service this product yourself. Refer all servicing to qualified service
personnel.

WARNING: The projector and its accessories come packaged in plastic bags. Keep plastic bags away from small
children to avoid any risk of suffocation.

Caution: When you replace the lamp, never touch the new lamp with your bare hands; the invisible residue left by
the oil on your hands may shorten the lamp life. Use a cloth or glove to handle the new lamp.
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Welcome

The PowerLite® 83+ is a portable projector that weighs less than 7
pounds, and offers up to 2200 lumens of brightness (white light
output and color light output). From classrooms to boardrooms, your
full-color presentations and videos will be bright and vibrant even in
ordinary indoor lighting.

Images are displayed at a native resolution of 1024 x 768 pixels.
Epson 3LCD technology ensures true to life color and remarkable
saturation, even in well-lit rooms.

You can connect the projector to a wide range of computers, including
IBM®-compatible PCs and laptops, Apple® Macintosh® PowerPC®
and Intel® Core™ Macintosh computers, PowerBook® computers,
and many iMac® and iBook® series systems. With Epson’s patented
SizeWise™ technology, the projector supports computer displays
ranging from VGA through UXGA.

You can use any of the following video sources: HDTV, VCR, DVD
player, gaming console (such as Microsoft® Xbox;" Sony®
PlayStation® 3, and Nintendo Wii™), camcorder, or digital camera.
The projector supports NTSC, PAL, and SECAM video formats.

You can connect up to four devices to the projector at the same time.
With the projector’s Source Search button, you don’t even have to
identify your input source. Just press the button until you see the
image you want on the screen.

To prevent unauthorized use of the projector, you can assign a
password, create a user logo which is displayed at startup to identify
the projector, and disable the projector’s buttons through a full or
partial Operation Lock feature. For more information about security
features, see page 61.
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Getting the Most from Your Projector

Depending on your presentation, you can take advantage of any or all
of these options:

m Connecting to a laptop or other computer
If you want to connect the projector to a laptop or desktop
computer, see page 18. For additional presentation control, you
can connect an external monitor to view the presentation on your
computer simultaneously.

m Connecting to video sources
You can connect a DVD player, VCR, HDTV, camcorder, digital
camera, and other video sources to your projector. See page 24 for
instructions.

m Using the remote control
The remote control lets you switch from computer to video
sources, zoom in on part of your image, freeze or mute the
presentation, and adjust many other projector features. For
details, see Chapter 3.

m Enhancing sound in your presentation
By connecting your projector to external speakers, you can
enhance the audio impact of your presentations.



Using Your Documentation

In addition to this manual, your documentation includes a Quick
Setup sheet, warranty brochures, and an Epson PrivateLine® Support
card.

The Quick Setup sheet gives instructions to quickly set up your
projector and connect it to a computer or video device.

This book contains all the information you need to set up and use
your projector. Please follow these guidelines as you read through it:

m  Warnings must be followed carefully to avoid bodily injury.
m Cautions must be observed to avoid damage to your equipment.

m Notes contain important information about your projector.

Getting More Information

Need quick steps for setting up your projector? Here’s where you can
look for help:

m Built-in help system
Press the Help button on the remote control or projector to get
quick solutions for common problems. See page 78 for details.

B www.epson.com/support
Download FAQs (frequently asked questions) and e-mail your
questions to Epson support on the PowerLite 83V+.

If you still need help after checking this User’s Guide and the sources
listed above, you can use the Epson PrivateLine Support service to get
help fast. Call (800) 637-7661 and enter the PIN on your PrivateLine
Support card. See page 87 for more information.
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Registration and Warranty

Your projector comes with a basic warranty that lets you project with
confidence. For details, see the warranty brochure included with your
projector.

In addition, Epson offers free Extra Cares™ Road Service. In the
unlikely event of an equipment failure, you won’t have to wait for
your unit to be repaired. Instead, Epson will ship you a replacement
unit anywhere in the United States or Canada. See the brochure
included with your projector for details.

You can register using the included CD, or you can register online at
WWW.epson.com/webreg. Registering also lets you receive special
updates on new accessories, products, and service.

Unpacking the Projector

After unpacking the projector, make sure you have all these items:

5 PASSWORD PROTECTED

Password Protected
Sticker

Remote control
and batteries

=)

PDF User's Guide
Power cord CD-ROM

Save all packaging in case you need to ship the projector. Always use
the original packaging (or equivalent) when you send the projector to
another location. See page 76 for transportation instructions.
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Projector Parts
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Control Panel
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Additional Components

Depending on how you plan to use the projector, you may need
additional components:

m To receive an S-Video signal, you need an S-Video cable. One is
usually provided with your video device or you can purchase it
from Epson. See page 13.

m To receive a component video signal from a VCR or other video
device, you need a D-sub, 15-pin, component-to-VGA video
cable, which is available from Epson. See page 13.

m To receive an audio signal, you need a commercially available

audio cable; see your computer or electronics dealer.



Optional Accessories

To enhance your use of the projector, Epson provides the following

optional accessories:

Product Product number
Replacement lamp V13H010L42
Air filter set (includes 2 filters) V13H134A13
Component-to-VGA video cable ELPKC19
S-Video cable ELPSV01
Distribution amplifier ELPDAO1
50-inch portable screen (4:3 aspect ratio) ELPSCO06
80-inch portable pop-up screen (4:3 aspect ratio) ELPSCO08
Accolade® Duet™ Ultra Portable Projector screen ELPSC80
(4:3 and 16:9 aspect ratio)
DC-06 document camera (ELPDCO06) V12H321001
DC-10S document camera ELPDC10S
Kensington® security lock ELPSLO1
Universal projector ceiling mount ELPMBPJF
Advanced Projector Ceiling Mount with Precision ELPMBPRG
Gear
False ceiling plate kit ELPMBP02
Adjustable suspended ceiling channel kit ELPMBPO1
Structural Round Ceiling Plate ELPMBPO3
Adjustable Extension Column (Pipe) 8"-11" ELPMBCO1
High Security Projector Ceiling Mount ELPMBATA
Soft Carrying Case, Projector Only (ELPKS60) V12H001K60
Molded Hard Shell Wheeled Carrying Case ELPKS58
Soft Shoulder Case for Projector/Notebook ELPKS61
Replacement Projector Remote Control 1456641
AP-60 Projector Sound Solution V12H329020

You can purchase screens, carrying cases, or other accessories from an
Epson authorized reseller. To find the nearest reseller, call
800-GO-EPSON (800-463-7766). Or you can purchase online at

www.epsonstore.com (U.S. sales) or www.epson.ca (Canadian sales).

Welcome
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Setting Up the Projector

This chapter tells you how to set up the projector and connect it to a
computer or video source. You can connect up to four devices
simultaneously: four video sources, or two computer and two video
sources.

You'll find instructions for the following in this chapter:
m Positioning the projector
m Connecting to a computer

m  Connecting to video sources

15



Positioning the Projector

Before connecting the projector, you
need to decide where to place it. If
you’re setting up the projector yourself
and it isn’t already installed in the
room you're using, you'll probably
want to place it on a table in front of ~=
the screen, as shown. 'S

This lets you stand in the front of the room, face the audience, and
note remain close enough to the equipment to be able to control it. Try to
You can use the Image Size leave as much space as possible between the projector and the screen to

Calculator on the Epson P
et a good-size image.
website to determine how g g g

large an image will be at Place the projector somewhere between 3 and 30 feet from the screen.
different projection Use the figure below to help you determine exactly how far. Image size
distances. increases with distance, but can vary depending on how you'’ve

adjusted the optical zoom and other settings.

Who We Are

Who We Are

2 '8t 1_'“:\
N
EPSON '_l,_l..,‘ v L ﬁ

28 to 34 ft (4:3) 5.6 to 6.8 ft (4:3) 2.7to 3 ft (4:3)
31 ft (16:9; wide only) 6.1to 7.3 ft (16:9) 3to 3.6 ft (16:9)

Also keep these considerations in mind:
m  Place the projector on a sturdy, level surface.

m  Make sure there is plenty of space for ventilation around and
under the projector. Do not set the projector on top of loose
papers that could block the vents under the projector.

m  Make sure the projector is within 6 feet (2 meters) of a grounded
electrical outlet or extension cord.
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Try to place the projector directly in front of the center of the screen,
facing it toward the screen squarely. If the projector isn’t positioned
this way, the image will be “keystone” shaped, instead of square or
rectangular.

If you place the projector below the level of the screen, you’ll have to
tilt it up by extending the front adjustable foot, as described on

page 39. This also causes the image to lose its rectangular shape. You
can adjust the shape using the buttons on the projector (see page 40),
or using the projector’s menu system (see page 49).

The Auto Keystone feature corrects the distortion automatically. See
page 57 for more information about Auto Keystone correction. If
necessary, you can adjust the image shape manually as described on
page 40.

Other Installations

You can also project from behind the screen or from the ceiling, with
the projector mounted upside-down:

Rear projection (using a Front/ceiling projection Rear/ceiling projection (using
translucent screen) a translucent screen)

To project from overhead, you'll need the optional ceiling mount
hardware. (See page 13 for ordering information.) You'll also need to
select Front/Ceiling or Rear/Ceiling for the Projection option in the
Extended menu. To project from the rear, select Rear. See page 58 for
more information.

Setting Up the Projector
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note

If you have an iBook with
an RCA video-out port,
follow the instructions for
connecting to a video device
on page 25.

Connecting to a Computer

You can connect the projector to any computer that has a standard
VGA or BNC monitor port, including PC notebook and laptop
computers, Macintosh PowerBooks and iBooks, and hand-held
devices.

Follow the instructions in this section to:

m  Connect the projector to your computer with the VGA cable
included with the projector.

m Connect the projector to your computer with a commercially
available VGA-5BNC cable.

After connecting the projector to your computer, you may also
want to:

m Connect a monitor to the projector so you can view your
presentation close-up as well as on-screen (not necessary if you're
using a laptop); see page 21.

m  Connect the projector to your computer with a commercially
available audio cable to play computer audio; see page 22.

Connecting with the VGA Cable

Follow these instructions to connect to your computer with the VGA
cable that came with your projector. Before you start, make sure your
computer and the projector are turned off.

1. If you are connecting the projector to a desktop computer,
disconnect the monitor cable from your computer.

2. Locate the VGA computer cable that came
with the projector.

VGA computer cable

18 Setting Up the Projector



Connect one end of the cable to the projector’s Computerl or
Computer?2 port.

Computerl and Computer2 ports

00000000000 00O00O0OO00O
00000000000 000000000
00000000000 00O00O0OO00O0
00000000000 000000000
00000000000 00O0OOOO00O0
000000000000000000O00
000000000000 00OOOO00O0
0000000000000 0000000
00000000000 000000000

00000000000000000000

KOOOOOOOOOOOOOOOOOOOO

3. Connect the other end of the cable to your computer’s video-out
or monitor port.

4. If you connected the computer to the Computerl port and you
want to view the display simultaneously on your computer
monitor and the projector screen, see “Connecting an External
Monitor” on page 21.

5. To play audio from your computer through the projector
speakers, see “Playing Sound Through the Projector” on page 22.

6. Tighten the screws on the connectors.

If you don’t need to make any other connections, you can plug in
your projector and turn it on. See page 34 for instructions.

If more than one device is connected to the projector, select the
correct source after projection starts by pressing the Source Search
button on the projector or remote control. See page 36.

Connecting with a VGA-5BNC Cable

If your computer provides video output through BNC connectors,
follow these instructions to connect the projector to your computer
with an optional VGA-5BNC cable. Before you start, make sure your
computer and the projector are turned off.

VGA-5BNC cable

1. Disconnect the monitor cable from your computer.

Setting Up the Projector 19
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2. Connect the cable’s VGA connector to the projector’s
Computerl or Computer2 port.

Computerl and Computer2 ports

S-Video Video L-Audio-R Computer2 Computer1

0000000000000 0O0O0O000O0
0000000000000 0000000
0000000000000 0O0O0O000O0
0000000000000 0000
0000000000000 00O00
0000000000000 0000
0000000000000 0O000
0000000000000 0000

o]

o

o]

0000000000000 000
0000000000000 000
\OOOOOOOOOOOOOOOO

00000000

[ele]
oo
[e)e]
[e]e]
[e)e]
[ele]
[e)e]
oo

3. Connect the BNC connectors to your computer’s BNC ports.

4. If you want to view the display simultaneously on your computer
monitor and the projector screen, see “Connecting an External
Monitor” on page 21.

5. To play audio from your computer through the projector
speakers, see “Playing Sound Through the Projector” on page 22.

6. Tighten the screws on the VGA connector.

If you don’t need to make any other connections, you can plug in
your projector and turn it on. See page 34 for instructions.

If more than one device is connected to the projector, select the
correct source after projection starts by pressing the Source Search
button on the projector or remote control. See page 36.



Connecting an External Monitor

If you want to see your presentation close-up as well as on the
projection screen, you can connect an external monitor to the
projector. This lets you view images on your computer monitor while note

the projector is in standby mode (plugged in but not turned on) and Some LCD monitors may
check your presentation or switch between picture sources even if not be able to display the
you've pressed the A/V Mute button on the remote control to turn off image correctly. If you have

trouble displaying the
image, connect a multiscan
Simultaneous display is possible only when the computer is connected monitor. If you're projecting

projection on the screen.

to the projector’s Computerdl port. computer images, make sure
the computer’s refresh rate is
Make sure the projector and computer are off. Then connect the set to 65 Hz or greater.

monitor’s cable to the projector’s Monitor Out port, as shown:

If you don’t need to make any other connections, you can plug in
your projector and turn it on. See page 34 for instructions.

Setting Up the Projector 21



Playing Sound Through the Projector

You can connect a commercially available 3.5 mm stereo mini-jack
audio cable to take advantage of the projector’s built-in speaker. You
can obtain the audio cable from a computer or electronics dealer.

1. Connect one end of the 3.5 mm stereo mini-jack audio cable to
the corresponding Audiol or Audio2 jack on the projector.

S-Video Video L-Audio-R Computer2 Computer1

Audiol
[~ and
Audio2

000

[eJeYe]

000 H
000 jacks
000

2. Connect the other end of the audio cable to your laptop’s
() headphone jack or %) audio-out jack, or your desktop’s
speaker or audio-out port.

If you don’t need to make any other connections, you can plug in
your projector and turn it on. See page 34 for instructions.

22 Setting Up the Projector



Connecting External Speakers

You can output sound to external speakers with built-in amplifiers.
When you play sound through external speakers, the projector’s
built-in speaker system is disabled.

1. Locate the appropriate cable to connect your speakers.

Depending on your speakers, you may be able to use a
commercially available audio cable with a stereo mini-jack
connector on one end and pin jacks on the other end. For some
speakers, you may have to purchase a special cable or use an
adapter.

2. Connect the stereo mini-jack end of the audio cable to the Audio
Out port on the projector.

3. Connect the other end of the cable to your speakers.

When you use external speakers with the projector, you can use the <0
or <) volume buttons on the projector or the Vol- and Vol+ buttons
on the remote control to adjust the volume. First, you need to select
the maximum volume on the external speakers. Then you can use the
projector or remote control buttons for further adjustments.

Setting Up the Projector
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note

The projector does not
support TV antenna cable
F connectors.

Connecting to Video Sources

You can connect a DVD player, VCR, camcorder, digital camera,
gaming console, or any other compatible video source to your
projector. You can connect up to four video devices at one time.

The projector supports HDTV, SDTV, NTSC, PAL, and SECAM,
and automatically detects the video format. It can receive composite
video, S-Video, RGB video, and component video. The type of cable
you need depends on the video source:

m For composite video, use a commercially available RCA A/V
cable. See page 25.

m For S-Video, use the S-Video cable supplied with your video
device or order one from Epson. See page 26.

m For RGB video, use the VGA computer cable included with the
projector. See page 27.

m For component video, you'll need the optional Epson
component-to-VGA video cable. See page 28.

After connecting your video device to the projector, you may want to
connect an audio cable to play sound from your video equipment
through the projector’s built-in speaker or external speakers. See
page 29 for instructions.

24 Setting Up the Projector



Connecting a Composite Video Source

If you’re connecting a composite video device, use a commercially
available RCA A/V cable. Before starting, make sure the projector and
your DVD player or other video source are turned off.

1. Connect the yellow RCA plug on one end of the cable to the
projector’s yellow Video port.

Video port

S-Video Video = L-Audio-R Computer2 Computer1
Audio2 Audiol .
0000000000000
00000000
o

0000000000000 0000000
KOOOOOOOOOOOOOOOOOOOO

OOOOOOOOOOOOOOOOOOOOJ

2. Connect the yellow plug on the other end of the cable to the
video-out port on your video source.

3. To play sound through the projector, follow the instructions
beginning on page 29.

If you don’t need to make any other connections, you can plug in

your projector and turn it on. See page 34 for instructions.

If more than one device is connected to the projector, select the
correct source after projection starts by pressing the Source Search
button on the projector or remote control. See page 36.

Setting Up the Projector 25
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Connecting an S-Video Source

If your video source has an S-Video jack, you can use it to project a
higher quality video image. You'll need an S-Video cable, which is
usually provided with your video source, or you can purchase one
from Epson (part number ELPSVO01). See page 13 for ordering
information.

Before starting, make sure the projector and your DVD player or
other video source are turned off.

1. Insert one end of the S-Video cable into the projector’s S-Video
port and the other end into the S-Video output port of your video
source.

S-Video port

S-Video Video  L-Audio-R Computer2 Computer1
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2. To play sound through the projector, follow the instructions
beginning on page 29.

If you don’t need to make any other connections, you can plug in

your projector and turn it on. See page 34 for instructions.

If more than one device is connected to the projector, select the
correct source after projection starts by pressing the Source Search
button on the projector or remote control. See page 36.



Connecting an RGB Video Source

Follow these instructions to connect the projector to a video player or
satellite receiver that has an RGB video output port using the VGA
computer cable that came with the projector.

Before starting, make sure the projector and your DVD player or
other video source are turned off.

1. Connect one end of the VGA computer cable to the Computerl
or Computer2 port on the projector.

Computerl and Computer2 ports
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2. Connect the other end to the video port on your player.

3. To play sound through the projector, follow the instructions
beginning on page 29.

If you don’t need to make any other connections, you can plug in

your projector and turn it on. See page 34 for instructions.

If more than one device is connected to the projector, select
Computer 1 or Computer 2 as the source after projection starts by
pressing the Source Search button on the projector or remote
control. See page 36.
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Connecting a Component Video Source

If your video source has component video connectors, you can use
them to project a higher quality video image. You'll need a
component-to-VGA video cable, which can be purchased from Epson
(part number ELPKC19). See page 13 for ordering information.

Before starting, make sure the projector and your DVD player or
other video device are turned off.

1. Connect the 15-pin VGA connector end of the
component-to-VGA video cable to the projector’s Computerl or
Computer2 port.

Computerl and Computer2 ports

S-Video Video L-Audio-R Computer2 Computer1

O)

00000000000
00000000000
00000000000
00000000000
00000000000
00000000000
00000000000
00000000000
00000000000
00000000000
00000000000
00000000000
00000000000
00000000000
00000000000
00000000000
00000000000
00000000000
00000000000
00000000000

—

-

2. Insert the three component ends of the component-to-VGA video
cable into the color-coded video output ports on your video
source, usually labelled Y, Pb, Pror Y, Cb, Cr.

3. To play sound through the projector, follow the instructions
beginning on page 29.

If you don’t need to make any other connections, you can plug in

your projector and turn it on. See page 34 for instructions.

If more than one device is connected to your projector, select
Computerl or Computer2 as the source by pressing the Source
Search button on the projector or the remote control. See page 36.
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Playing Sound Through the Projector

The projector has a built-in speaker with a maximum output of 10 W.
You can play sound from your video equipment through the
projector’s speaker if your video device has an audio output port.

For RCA-Type Audio Output Ports

Most video devices have an RCA-type audio output port. In this case,
use a commercially available RCA-type audio cable to connect the
projector to your video source:

1. Connect one end of the RCA audio cable to the L-Audio-R jacks
on the projector.

L-Audio-R jacks
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2. Connect the red and white plugs on the other end of the RCA
audio cable to the corresponding color-coded audio output port
on your video source.

If you don’t need to make any other connections, you can plug in
your projector and turn it on. See page 34 for instructions.

Setting Up the Projector
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For Stereo Mini-Jack Audio Output Ports

Some video devices, especially camcorders, may have a stereo
mini-jack audio output port. To connect to the L-Audio-R input
jacks when using the S-Video or Video port, use a commercially
available stereo mini-jack audio adapter cable (3.5-mm stereo
miniplug to two male RCA plugs) to connect to the projector.

1. Connect one end of the audio adapter cable to the L-Audio-R
jacks on the projector.

L-Audio-R jacks

L-Audic-R Computer2 Computer1

S-Video Video

Audio2 Audiol .

2. Connect the other end of the audio adapter cable to your video
device’s audio output port.

If you don’t need to make any other connections, you can plug in
your projector and turn it on. See page 34 for instructions.
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Connecting External Speakers

You can output sound to external speakers with built-in amplifiers.
When you play sound through external speakers, the projector’s
built-in speaker system is disabled.

1. Locate the appropriate cable to connect your speakers.

Depending on your speakers, you may be able to use a
commercially available audio cable with a stereo mini-jack
connector on one end and pin jacks on the other end. For some
speakers, you may have to purchase a special cable or use an
adapter.

2. Connect the stereo mini-jack end of the audio cable to the
Audio Out port on the projector.

3. Connect the other end of the cable to your speakers.

When you use external speakers with the projector, you can use the =<
or <) volume buttons on the projector or the Vol- and Vol+ buttons
on the remote control to adjust the volume. First, you need to select
the maximum volume on the external speakers. Then you can use the
projector or remote control buttons for further adjustments.

Setting Up the Projector
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Projecting

Once you've set up the projector, you’re ready to turn it on, adjust
the image, and give your presentation.

Although you can operate the projector without it, the remote control
lets you use additional features. See Chapter 3 for instructions on
using the remote. This chapter covers the following:

Turning on the projector and other equipment
Adjusting the image
Adjusting the volume

Shutting down the projector
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Turning On Your Equipment

Make sure your projector and other equipment are set up and
connected correctly, as described in Chapter 1. Then turn on your
projector, as described below.

If you turn on your connected computer or video equipment before
starting the projector, the projector automatically detects and displays
the image source. If you turn on the projector first, or have multiple
pieces of connected equipment, you may have to select the image
source manually. See page 36.

Turning On the Projector
Follow these steps to plug in and turn on the projector:

1. Open the A/V Mute slide (lens cover).

2. Connect one end of the power cord to the projector’s power inlet.
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3. Connect the other end to an electrical outlet. The © Power light
on top of the projector turns orange, indicating that the projector
is receiving power but not yet turned on.

4. Turn on your computer or video source if you have not already. note
| ) If you are using the remote
5. Press the O Power button on the projector or on the remote control for the first time, be
control to turn it on. sure to insert the batteries as

described on the Quick
Setup poster.

Power button

EPSON

Source
Power Search  Help

Menu A Esc

Vol—_ Enter/Auto Vol+

The projector beeps and the O Power light flashes green as the

. ) . warning
projector warms up. The prOchtor lamp comes on in about Never look into the lens when
5 seconds and the O Power light stays green. the lamp is on. This can

) : damage your eyes, and is
m If you're using a computer, you should see your computer especially dangerous for

display projected after a moment or two. If not, you need to children.
select the image source. See page 36.

(With Windows, if you see a message saying that it has found
a plug-and-play monitor, click Cancel.)

m If you're projecting a video, you may need to press the
Source Search button on the projector or remote control to
switch to your video source. Then press the Play button on
your DVD player or other device.

m |f you are prompted to enter a password, see page 66.

To focus and adjust the image, see page 38. If a projected image fails
to appear, see “What To Do If You See a Blank Screen” on page 36.

When you're done, shut down the projector as described on page 42.
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note

The name of the selected
image source appears briefly
in the upper right corner of
the screen.

36 Projecting

Selecting the Image Source

Selecting the image source lets you switch between images input from
different pieces of equipment connected to the projector (such as a
computer and DVD player). If you don’t see the image you want,
press the Source Search button on the remote control or projector
until the correct device image is projected. If a projected image fails to
appear, see the next section for help.

Once you see your image, turn to page 38 for instructions on focusing
and making other image adjustments.

What To Do If You See a Blank Screen

If you see a blank screen or a blue screen with the message No Signal
after turning on your computer or video source, try the following:

m  Make sure the cables are connected correctly, as described in
Chapter 1.

m  Make sure the O Power light is green and not flashing and the
A/V Mute slide is open.

m  Make sure you've selected the correct image source; see the
previous section. Allow a few seconds for the projector to sync up
after pressing the button.

m  Check the Signal menu to make sure the correct input source is
selected. See page 54.

If you’re using a PC laptop:

m Hold down the Fn key and press the function key that lets you
display on an external monitor. It may have an icon such as 2/0)
or it may be labelled CRT/LCD. Allow a few seconds for the
projector to sync up after pressing it. Check your laptop’s manual
or online help for details.

On most systems, the 2/) or CRT/LCD key lets you toggle
between the LCD screen and the projector, or display on both at
the same time.



If you're projecting from a laptop, and you don’t see the same
image on the projection screen and computer screen, check your
monitor settings to make sure both the LCD screen and the
external monitor port are enabled.

From the Control Panel, open the Display utility. Click the
Settings tab, then click Advanced. The method for adjusting
the settings varies by brand; you may need to click a Monitor tab,
then make sure the external Monitor port is set as your primary
display and/or enabled. See your computer’s documentation or
online help for details.

If you’re using a Macintosh laptop with OS X:

You may need to set up your system to display on the projector screen
as well as the LCD screen. Follow these steps:

1
2
3
4.
5
6

Open System Preferences.
Click Display or Displays.
Click Detect Displays.

Make sure the VGA Display or Color LCD dialog box is selected.

Click the Arrangement or Arrange tab.

Make sure the Mirror Displays checkbox is selected.
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Adjusting the Image
Once you see your image, you'll need to make certain adjustments:

m To focus or zoom your image, see below.

m If the image is too high or too low, you can reposition it.
See page 39.

m If the image isn’t square, see page 40.
m To adjust image brightness, see page 40.
m If acomputer image displays incorrectly, see page 41.

You can make many other adjustments to the image—such as
changing the brightness, contrast, and aspect ratio—using the
projector’s menu system. See Chapter 4 for more information.

Focusing and Zooming Your Image

Rotate the focus ring to sharpen the image, and the zoom ring to
reduce or enlarge the image.

Focus

Zoom

You can also change the image size by moving the projector closer to
or farther away from the screen. You can use the E-Zoom buttons on
the remote control to zoom in on a portion of the image. See page 47
for instructions.



Adjusting the Height of Your Image

If the image is too high or low, you can correct it by adjusting the
projector’s front foot.

1. Stand behind the projector. Press up on the blue foot release lever
and lift the front of the projector to extend the front adjustable
foot.

2. Once the image is positioned where you want, release the lever to
lock the foot in position.

The projector automatically corrects images that are distorted when
the projector is tilted up or down (up to a 30° tilt). The Keystone
window appears on the screen while the projector makes the
correction. If the projected image still isn’t rectangular, follow the
instructions in the next section.
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Adjusting the Image Shape

If the projector is tilted up or down, the images that are displayed will

be distorted. To correct the distortion or “keystone” shape, do one or

more of the following:

m If your image looks like [} or {} you’ve placed the projector
off to one side of the screen, at an angle. Move it directly in front
of the center of the screen, facing the screen squarely.

m If your image looks like j or : you need to adjust the
keystone correction value. Press the 7% or \_/ buttons on the
projector to correct the shape of the image. After correction, your
image will be slightly smaller.

L L

sC Menu

o000 o0o
q»g/@ D @i/@ D
J U

m You may need to turn on Auto Keystone. See page 56 for
instructions.

You can also make keystone adjustments using the projector’s Settings
menu. See page 56.

Adjusting the Brightness

The brightness of an image depends on the source you are projecting
and the amount of light in the room. If the image is too bright or not
bright enough, here are two ways you can adjust it:

m Change the Brightness setting in the Image menu. See page 53.

m Select Low or High for the Brightness Control option in the
Settings menu. (See page 57.) Low brightness mode extends the
life of the lamp and decreases the fan noise.



Correcting Computer Images

If you've connected a computer and the image doesn’t look right, or it
doesn’t fit properly on the screen, press the Enter button on the
projector or the Enter/Auto button on the remote control. This
automatically resets the projector’s tracking, sync, resolution, and
position settings. You must be projecting a computer image for this
button to have any effect. Additionally, if the Auto Setup option in
the Signal menu is set to Off, the Auto function will not work. See
page 55.

Adjusting the Volume

You can use the Vol- and Vol+ buttons on the remote control to
increase or decrease the volume.

You can also use the buttons on the projector to control the volume.
Press the <) button to increase the volume, or the <) button to
decrease it. A volume gauge appears on the screen while the volume is
being adjusted.

—_—
EPSON
Power St Help

OO

Menu A Esc

Vol—_ Enter/Auto Vol+

ColorMode Aspect

¥ o Freeze T~ /
p Volume control
A/VMute

O

buttons

~——

note

You can also adjust the
volume using the projector’s
Settings menu. See page 56
for details.

You must adjust the volume

separately for each input
source.
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note

When the projector has not
received any input signals
for 30 minutes, it
automatically turns off the
projector lamp and enters
“sleep mode.” This conserves
electricity, cools the
projector, and extends the
life of the lamp. If you are
done using the projector,
unplug the power cord. If
you want to start projecting
again, press the O Power
button. You can turn sleep
mode on or off through the
Extended menu. See

page 59.

Turn off this product when
not in use to prolong the life
of the projector.

caution

To avoid damaging the
projector or lamp,
never unplug the power
cord when the

O Power light is green
or flashing orange.
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Shutting Down the Projector

When you've finished using the projector, follow the recommended
procedure to shut it down.

1.

If you're using a computer, shut it down first; otherwise you may
not be able to see your computer’s display to shut it down

properly.

To turn off the projector, press the O Power button on the
projector or remote control.

You see this confirmation message:
(If you don’t want to turn it off,
press any other button or wait a
few seconds until it disappears.)

Power 0ff?

Yes: Press @ button
Ho - Press any other button

Press the O Power button again. The projector beeps twice, the
lamp is turned off, and the O Power light turns orange. (To turn
the projector on again, press the © Power button.)

With Epson’s exclusive Instant Off® technology there’s no
cool-down period, so you can pack up and go immediately after
turning off the projector.

Press up on the blue foot release lever and lower the projector to
retract the front adjustable foot.

Close the A/V Mute slide.

E3

Unplug the power cord.

Turn off and disconnect any equipment plugged into the
projector.

If you won’t be using the projector for awhile, store it in a
protective case.



Using the Remote Control

T he remote control lets you access your projector’s features from
anywhere in the room—up to 20 feet away. For example, you can turn
the projector on and off, freeze the presentation, zoom in on a portion
of your image, and access the menu system. (The projector menus let
you adjust many projector settings; see Chapter 4.)

When using the remote control, stand within 20 feet of the projector.
Point the remote control either at the front or back of the projector or
at the screen (the projector’s front sensor can detect signals bounced
off the screen). Press the button for the function you want to use.

This chapter covers the following information:
m  Controlling the picture and sound

m  Replacing the remote control batteries
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Controlling the Picture and Sound

You can use the remote control to select your source, adjust the colors,
temporarily turn off the picture and sound, freeze the action, or zoom
in on the picture. Make sure you have set up your projector and
connected any equipment as described in Chapter 1.

Switching Between Picture Sources

If you’ve connected your projector to more than one computer and/or
video source, you can use the Source Search button on the projector
or remote control to switch between the different sources.

EPSON

Source
Source
Power Ssearch  Help Search

)
«od D 5O

Vol— Enter/Auto Vol+

ColorMode I AS?QC(
‘: v

+ Freeze
p Source Search
A/VMute
D) button

D ——

After you select a source, the screen goes dark for a moment before the
image appears. The name of the selected source (such as Computerl
or S-Video) appears briefly on the screen.
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Adjusting the Color Mode

You may want to adjust the color mode to select a different setting
that is appropriate for the image you're projecting and the
environment in which you're projecting it. Press the Color Mode
button on the remote control.

If you’re projecting computer or RGB video images, the default color
mode is Presentation, which is appropriate for full-color
presentations in bright rooms.

The following table lists the color modes available.

Color mode Description

Photo Best for projecting still images with vivid color in a
bright room (computer input only).

Sports Best for watching TV in a bright room (component,
S-video, or composite video input only).

Presentation Use when you’re projecting a full-color presentation in
a bright room.

Text Use when you’re projecting a black and white
presentation in a bright room.

Theatre Use when projecting movies in a dark room.

Game Brightest mode, best for playing video games in a
bright room.

sRGB Use when projecting computer images conforming to
the sRGB color standard.

Blackboard Choose this fixed color mode when you need to

project against a green blackboard.

You can also use the projector menu system to change the color mode
in the Image menu (see page 53).

Color
Mode
button

—
EPSON
Power oy Help
Menu A Esc

Vol— Enter/Auto Vol+

ColorMode Aspect

v
+ Freeze
% A/VMute

D ——
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Freeze
button

Turning Off the Picture and Sound

Press the A/V Mute button on the remote control or use the

A/V Mute slide on the projector to turn off the image and sound and
darken your screen. This is useful if you want to temporarily re-direct
your audience’s attention without the distraction of a bright screen.

m To turn off the picture and sound, press the A/V Mute button or
close the A/V Mute slide on the projector. The screen goes dark.

Y

=
EPSON S OOZ
Power Serd  Help A/N Mute
OO slide
Menu A Esc
Vol— Enter/Auto Vol+
ColorMode Aspect
¥ Freeze
%A/vmme A/V Mute
I button
—

m To turn the image and sound back on, press the button again, or
open the AV Mute slide.

You can create an image, such as a company logo or a picture, to
display on the screen whenever you press the A/V Mute button. See
page 63 for more information.

Stopping Action

Press the Freeze button to stop the action in your video or computer
image and keep the current image on the screen. The sound will
continue, however. Also, because the source continues to transmit
signals, you won’t resume the action from the point you paused it.

To restart the action, press the Freeze button again.
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Zooming Your Image
Follow these steps to zoom in on a portion of the image:
1. Press the E-Zoom + button on the remote control.
You see a crosshair indicating the center of the zoom-in area.

2. Use the four “arrow” buttons on the remote control to position
the crosshair in the area you want to enlarge.

3. Continue pressing the E-Zoom + button to enlarge the selected

area up to 4 times.
4. While the image is enlarged, you can:
m  Use the arrow buttons to pan about.
m  Press the E-Zoom - button to zoom out.

5. When you’re done, press the Esc button to return to the origin
size.

Changing the Image’s Aspect Ratio

If you're projecting a widescreen format image, you can use the

Aspect button on the remote control to change the aspect (width to

height) ratio from 4:3.

You can change video images to 16:9 (widescreen format), or 16:9
(Up) or 16:9 (Down) (to accommodate subtitles or supertitles).

You can change computer images to 16:9 (widescreen format) or
Normal.

Press the Aspect button again to cycle through the available options.

You can also change the aspect ratio using the projector’s Signal
menu. See page 54 for details.

/ﬁ
EPSON
Power Ssarh  Help
Menu A Esc
Arrow |
buttons — =_Enter/Auto Vol+
; Freeze
E-Zoom
1| p
buttonS [~ A/VMute
s —
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EPSON
Power 3oy  Help
OO
Menu Esc
Vol— Enter/Auto Vol+
ColorMode Aspect Aspect
v é button
+ Freeze
—
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note

The remote control
automatically shuts off when
it detects a button being
pressed more than

30 seconds. This conserves
battery life. It can be
helpful, for example, when
the remote is in a carrying
case and the O Power
button is accidentally
pushed.

caution

When replacing batteries,
take the following
precautions:

m Replace the batteries as
soon as they run out. If a
battery leaks, wipe away
battery fluid with a soft
cloth. If fluid gets on your
hands, wash them
immediately.

m Do not expose batteries to
heat or flame.

m Dispose of used batteries
according to local
regulations.

m Remove the batteries if
you won't be using the
remote control for a long
period of time.

Replacing the Batteries

The remote control uses two AA alkaline batteries. Follow these steps
when you need to replace them:

1. Press in the tab to remove the battery cover.
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Fine-tuning the Projector

Y ou can use the Menu button on the projector or remote control to
access on-screen menus to adjust the image, sound, and other features.
This chapter covers the following information:

m Using the menu system

m Adjusting image colors and clarity

m  Adjusting the input signal

m  Customizing projector features

m  Selecting projector setup options

m Viewing lamp usage and other information
m Using the projector’s security features

m  Restoring the default settings
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Using the Projector’s Menu System

The projector menus let you adjust and customize the projector
features:

50 Fine-tuning the Projector

The Image menu lets you modify the colors of the projected
image and fine-tune brightness, contrast, and sharpness. See
page 52.

The Signal menu lets you make adjustments to the input signal.
You can select your input source, change the image position and
aspect ratio, and adjust tracking and sync for computer images.
See page 54.

The Settings menu lets you customize the way you use the
projector. It allows you to adjust the volume and keystone
correction, set lamp brightness to high or low, control use of the
remote control receivers, project a test pattern for adjustments,
and disable buttons on the projector while you are projecting. See
page 56.

The Extended menu lets you customize the way you set up the
projector. Among the options, you can select the menu language,
set rear or ceiling projection, turn closed captions on or off, and
record a custom image or logo to be displayed as the startup
screen or whenever you press the A/V Mute button on the remote
control. See page 58 and page 61.

The Info menu provides information about lamp status and
computer or video settings. See page 60.

The Reset menu lets you restore the projector’s factory default
settings. See page 68.



Changing Menu Settings

Use the buttons on the remote control or on the projector to access
the menus and change settings. Follow these steps:

1. Press the Menu button on the remote control or projector to
display the menu screen:

Menu options

Color Mode
Brightness
Contrast

Color Saturation
Menus — Tint

Sharpness
Calor Adjustment
Reset

(T#71:Select [Enter] :Enter [Menul-Exit |

The menus are listed on the left, and the options available for the
highlighted menu are shown on the right.

2. Use the up and down arrow buttons on the projector or remote
control to scroll through the menu list. When you’ve highlighted
the desired menu, press the Enter button on the projector or the
remote control to select it.

The highlight moves to the first option for that menu.

3. Use the up and down arrow buttons on the projector or remote
control to scroll through the list of options. (The options available
depend on which source is selected.)

4. After highlighting the option you want to adjust, use the left or
right arrow buttons on the projector or the remote control to
change the setting. In some cases, you may have to press the Enter
button to see a sub-screen for changing the setting.

Fine-tuning the Projector
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r Y — O Press the left or right. arrow puttons on the projector or the
remote control to adjust a slider bar.

10n To select from two or more settings, use the up or down arrow
10ff buttons on the projector or the remote control to highlight the
desired setting, then press Enter.

5. Press the Esc button to return to the previous menu or to close
the menu system if you are at the main menu. Your changes are
saved automatically.

6. Press the Menu button to exit the menu system.

Adjusting Colors and Clarity

The Image menu lets you make adjustments to the colors of the
projected image and fine-tune brightness, contrast, and sharpness.
The options available depend on which image source is selected:

Computer (analog-RGB)
and RGB video
Color Mode
Brightness
Contrast
Sharpness
Color Adjustment
Reset

Component,
composite, and S-Video
Color Mode
Brightness
Contrast
Color Saturation
Tint
Sharpness
Calor Adjustment

Reset

(T#71:Select [Enter] :Enter [Menul-Exit |
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Follow these steps to adjust the appearance of your image:

1.
2.
3.

Press the Menu button. You see the main menu.
Press Enter to select the Image menu.

Use the up and down arrow buttons and press Enter to set the
following options:

m Color Mode
Corrects the vividness of image color. You can select from the
following settings, and save a different one for each computer
and/or video source:

Photo: For projecting still images with vivid color in a bright
room (Computer input only).

Sports: For watching TV in a bright room (component,
S-Video, or composite video input only).

Presentation: For color presentations in a bright room.
Text: For black and white presentations in a bright room.

Theatre: For optimizing movie images with natural color in a
dark room (the default for video or S-Video display).

Game: Brightest mode, for playing video games in a bright
room.

sRGB: For standard SRGB computer displays (the default
when projecting from a computer with analog video).

Blackboard: Fixed color mode for projecting against a green

blackboard.
m Brightness
Lightens or darkens the overall image. note
You can also select High or
m  Contrast Low brightness mode in the
Adjusts the difference between light and dark areas. Settings menu. See page 57.

m Color Saturation (component, composite, and S-Video)
Adjusts the depth or intensity of the image colors.

Fine-tuning the Projector 53



m Tint (component, composite, and S-Video)
Adjusts the balance of green to magenta in the image.

m Sharpness
Sharpens or softens the image.

m Color Adjustment
Adjusts the temperature and intensity of red, green, and blue.

4. When the image is set correctly, press Esc or Menu. Your settings
are automatically saved.

Adjusting the Input Signal

Although the projector normally detects and optimizes the input
signal automatically, you can use the Signal menu to manually select
it. You can also change the position of the projected image, correct
tracking and sync, and change the aspect ratio to widescreen format.

1. Press the Menu button. You see the Image menu.

2. Select the Signal menu. You see one of the following screens:

Return

Computer! Input
Computer? Input
Aspect

Reset

Computer (analog-RGB) and RGB video Component video

Return

Composite video and S-Video
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Press Enter. Then use the up and down arrow buttons and the
Enter button to set the following options:

m  Auto Setup (computer images)
Leave this setting On to automatically optimize the computer
image. Turn it off if you want to save adjustments you have
made to the video settings.

m Tracking (computer images)
Removes unwanted vertical lines from a computer image by
matching the projector’s internal clock to various computer
signals. See page 84 for more information.

m  Sync (computer images)
Corrects fuzziness or screen flicker by synchronizing the .
projector with the tracking signal sent from the computer. I you have repositioned the
. . image but then change your
See page 84 for more information. mind, you can press the
Enter/Auto button on the

remote control to restore the
default settings.

note

m Position (computer images)
Use the arrow buttons to move the image on the screen left,
right, up, or down.

m Progressive
Leave this setting On when viewing S-Video or composite
video so that interlaced-to-progressive conversion is carried
out (best for fast-moving pictures). If you notice flickering
while viewing still images, switch this setting to Off.

m  Computer Input (1 or 2)
Selects the signal from equipment connected to the
Computerl or Computer2 ports. If your image colors look
wrong, try changing this setting from Auto to one of the
following: RGB for computer or RGB video sources, or
Component Video for component video sources.
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m Video Signal (composite and S-Video)
Leave this setting at Auto unless you are using a 60-Hz PAL

system (select PALGO).

B Aspect

Sets the image’s aspect ratio (ratio of width to height). Select
4:3 for Normal for computer content, 4:3 for letterbox video
content, 16:9 for widescreen content, or 16:9 (Up) or 16:9
(Down) for video content with subtitles or supertitles.

4. When you’re finished, press Esc or Menu.

Customizing Projector Features

The Settings menu lets you customize the way you use the projector,
from adjusting volume and lamp brightness to applying security

controls.
1. Press the Menu button.

2. Select the Settings menu.

Image
Heystone

Signal Auto Keystone
Operation Lock

Settings Brightness Control
Volume

Extended Remote Receiver
Test Pattern

Infa Reset

Reset

Return
[i]
Off
Full Lock

Front/Rear

[ [#1:Select [Enter] :Enter
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Press Enter. Then use the up and down arrow buttons and the
Enter button to set the following options:

Keystone
Adjusts a distorted image from a trapezoid shape to
rectangular.

Auto Keystone

Automatically adjusts a distorted image from a trapezoid
shape to rectangular when the projector’s foot is extended or
retracted. (Not available when you’re projecting from the
ceiling or using rear projection.) Select On or Off.

note
To cancel the Operation
Lock function from the

Operation Lock
Disables all projector buttons (Full Lock) or all the buttons

except the O Power button (Operation Lock). You can still projector, press the Enter
operate the projector from the remote control. Changes to button for about seven
this setting take effect after you restart the projector. (After seconds.

you turn off the projector, wait for the O Power light to turn
a steady orange before turning it on again.)

Brightness Control

Select Low lamp brightness when the projection is too bright
for the room. The Low setting also reduces electricity
consumption and fan noise. Select High to project the
maximum brightness. (Also check the Brightness setting in
the Image menu; see page 53.)

Volume
Adjusts the volume.

Remote Receiver

Deactivates the projector’s front and/or back sensors that
detect signals from the remote control. This may be necessary
to prevent interference from bright fluorescent lights.

Test Pattern

Displays a test pattern to assist you in focusing and zooming
the image, and correcting the image shape. (To cancel the
displayed test pattern, press Esc.)

When you're finished, press Esc or Menu.
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Selecting Projector Setup Options

Use the Extended menu to customize the way you set up the
projector. You can configure the projector for rear and/or ceiling
projection, change the language for the menus and messages, set the
screen background color, capture and store a custom image or logo for
the startup screen.

1. Press the Menu button.

2. Select the Extended menu.

Image Return
Display

Signal Uiser's Logo
Projection Front

Settings Operation
Language &) English

Extended +] Reset

Info

Reset

[T#7:Select [Enter] :Enter [Menul:Emt |

3. Press Enter. Then use the up and down arrow buttons and the
Enter button to set the following options:

m Display
Messages: Lets you turn screen messages on or off.

Display Background: Sets the screen background to Black,
Blue, or Logo when no image signal is available.

Startup Screen: Enables or disables display of the startup
screen when the projector is turned on.

A/V Mute: Sets the screen background to Black, Blue, or
Logo when the A/V Mute button is pressed.

Closed Caption: Enables or disables closed captions. Select
CC1, CC2, or OFF. The captions are not visible when the
menu is displayed.
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m User’s Logo

Turn on to display the image or logo you have captured
whenever the projector is turned on. See page 63 for more
information.

Projection
Front: Projector is in front of the screen.

Front/Ceiling: Projector is in front of the screen, mounted
upside-down from the ceiling.

Rear: Projector is behind the screen.

Rear/Ceiling: Projector is behind the screen, mounted
upside-down from the ceiling.

To change from Front to Front/Ceiling or Rear to
Rear/Ceiling, press and hold the A/V Mute button on the
remote control for five seconds.

Operation

Direct Power On: When this feature is enabled, projection
starts as soon as you plug in the power cord. You don’t have
to press the O Power button.

Sleep Mode: When enabled, the projector turns off the lamp
if it has not received any input signals for a period of time (as
defined in the Sleep Mode Time setting).

Sleep Mode Time: When Sleep Mode is on, you can set the
period of time before the projector turns off automatically,
from 1 to 30 minutes.

Lens Cover Timer: This feature is enabled by default to turn
the power off automatically when the A/V Mute slide is
closed for more than 30 minutes.

High Altitude Mode: When using the projector at an
altitude above 4,921 feet (1,500 meters), turn this setting on
to ensure that the internal temperature of the projector is
regulated properly. Turn this setting off for lower elevations.

Language
Select the language to be used for the projector menus.

4. When you're finished, press Esc or Menu.

note

Logo settings cannot be
changed if the User’s Logo
Protect feature has been
turned on. See page 64.

note

When Direct Power On
is turned on, press the

O Power button to turn
the projector off, wait until
the O Power light turns a
steady orange, then unplug
the power cord.
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note

You can make changes to
many of the signal settings
on the Signal menu. See
page 54 for details.

Viewing Lamp Usage and Other
Information

Use the Info menu to view information about the display settings of
your computer and the number of hours the lamp has been used.

1. Press the Menu button.

2. Select the Info menu. You see one of the following menus:

Image Image
Lamp Hours Lamp Hours
Signal High Brightness 0 H Signal High Brightness 0 H
Low Brightness 0 H Low Brightness L |
Settings Source Computeri Settings Source Computeri
Input Signal Auto Video Signal Auto [----)
Extended Resolution 0Dx 0 Extended Status
Refresh Rate 0,00 Hz
Info Sync Info SGHH 00000 Info
Status
Reset Reset
[T#7:Select [Enter] :Enter [Menul:Exit = [[#1]:Select [Enter] :Enter [Menul:Exit
Computer (analog RGB, digital RGB, RGB Video (Composite video, S-Video)

Video/Component video)

note

The lamp usage timer
doesn’t register until you've
used the lamp for at least
10 hours.

®m Lamp Hours
Displays the number of hours the lamp has been used. The
life span of the lamp ranges from about 3000 hours in High
brightness mode to about 4000 hours in Low brightness
mode. If the number shown is close to 3000 or the
information is displayed in red, make sure you have a spare
lamp handy.

m Source
Displays the input source currently being projected.

m Input Signal (computer, RGB video, and component video)
Displays the input signal setting.

m Resolution (computer, RGB video, and component video)
Displays the input resolution.

m Video Signal (composite and S-Video)
Displays the video signal format.
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m Refresh Rate (computer, RGB video, and component video)
Displays the refresh rate.

m  Sync Info (computer, RGB video, and component video)
Provides information that may be needed by the service
technician.

m Status
Displays informations about projector problems. This
information may be needed if service is required.

3. When you're finished, press Esc or Menu.

Using the Projector’s Security Features

To prevent unauthorized use of the projector, you can do the
following:

m Create an identifying user logo that is displayed at startup and/or
when the A/V Mute button is pressed.

m  Assign a password to prevent the projector from being turned on,
and prevent your startup screen from being changed.

m Disable the projector’s buttons; this is useful, for example, if
you're projecting in a classroom and you want to ensure that no
one touches the projector’s buttons while you're using the remote
control.

m Install an anti-theft lock.

If you create a user’s logo for the projector, you can lock the logo on so
it is displayed as the startup screen and/or AV/Mute screen.
Unauthorized users cannot turn it off or change it. This feature is
intended to discourage theft and provides a way to identify the
projector should it be stolen.
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note

If you should happen to
enable the password before
you set one and you see the
prompt to enter the
password, enter the default
password 0000 to proceed.

If you assign the projector a password, a screen appears requesting the
password whenever the projector is turned on. If you enter the
password incorrectly three times in succession, the projector’s
operation is locked and you’ll need to disconnect the power cord, then
reconnect it to redisplay the password screen. If an incorrect password
is entered 30 times in a row, the projector is locked and you’ll need to
contact Epson to unlock it. See “Where To Get Help” on page 87.

If someone else will be using the projector for awhile but you want to
make sure that person returns it by a certain time, you can temporarily
disable the password for a set period. When that time has elapsed, the
password is reactivated and must be entered before the projector can
be used.

When you enable the Operation Lock feature, all of the projector’s
buttons (Full Lock) or all of the buttons except the O Power button
(Operation Lock) are disabled.
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Creating Your Own Screen Logo

You can transfer any image on your computer to the projector, and
then use it as the startup screen and/or the screen that is displayed
when you press the A/V Mute button. The image can be a company
logo, slogan, photograph, or any other image you want to use. The
projector considers this image the “User’s Logo.”

Follow these steps to capture the image and transfer it to the projector:

1. Display the image you want to use on the projector. You can use
an image from a computer or video source, such asa DVD player.

2. Press the Menu button and select the Extended menu.

note
= If the User’s Logo Protect
eturn . .
Display function is ON, you see a
g“‘.'_% Lago _ message that the logo cannot
rojection Front

Operation be recorded. You'll need to
Language G 2L disable the User’s Logo

Protect function before you
can create or change the
User’s Logo. See page 65.

(T#71:Select [Enter] :Enter [Menul-Exit |

3. Use the down arrow button and press Enter to select User’s
Logo.

4. When you see a message asking if you want to use the present
image as a user’s logo, select Yes and press Enter. A selection box
displays over the image.

5. Use the arrow buttons on the projector or remote control to select
the area of the image you want to use. Once you have selected the
area, press Enter.

6. When you see the message Choose this image as the User’s
Logo?, choose Yes and press Enter. If you want to change the
area selected, select No, press Enter and repeat steps 5 and 6.
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note

The default setting for the
Startup Screen option
menu is On. If the Startup
Screen is set to Off, the
logo will not display at
startup.

If the User’s Logo Protect
function has been set to On,
the Display Background
setting cannot be changed.
You need to turn the protect
function off first. See

page 65 for details.

Once you've saved a user’s
logo, you cannot reset the
logo setting to its factory
default (no logo).

note

If a password has already
been set, you see the
Password Protect Release
screen. See “Starting the
Projector with a Password”
on page 66.

7. When you see this screen, select a zoom rate (display size), and

then press Enter.

[User's Lago]

Set the zoom factor.

Zoom factor:

(TEscl:Return [#1:Select [Enter] :Set [Menul:Exit |

8. When you see the message Save image as user’s logo?, select

Yes and press Enter. Saving the logo takes a few moments. Do
not use the projector or other sources (computer, video, etc.)
while the logo is being saved. When you see the message
Completed, press Esc.

To display the logo as the background screen when you press the
A/V Mute button or when no image signal is available, select the
Extended menu and press Enter. Then select Display, Display
Background, and Logo and press Enter. Select A/V Mute and
Logo and press Enter.

10. When you're finished, press Menu to exit the menus.

Setting a Password

1.

64 Fine-tuning the Projector

Press the Freeze button on the remote control for about five
seconds until you see the Password Protect menu:

[Password Protect]

Power On Protect QOHf
User's Logo Protect  Off
Metwork Protect Off

Password

(T#71:Select [Enter] ;Enter [Menul:Exit

Select Password and press Enter.



3. When you see the message Change the password?, select Yes
and press Enter.

4. Enter a 4-digit number using the numeric buttons on the remote
control, as shown.

The password will be displayed as ****, After you enter the last
digit, a confirmation screen appears. Enter the password again.
You see the message Password accepted.

5. After you finish setting the password, press the Esc button to
return to the Password Protect menu.

Make a note of the password and keep it in a safe place in case you
forget it.

Turning On the Password and User’s Logo

1. Press the Freeze button on the remote control for about five
seconds until you see the Password Protect menu.

2. Toenable the password, select Power On Protect and press
Enter. Select On then press Esc.

3. Toenable your screen logo, select User’s Logo Protect and press
Enter. Select On then press Esc.

When this feature is on the logo appears whenever the projector is
turned on (if the Startup Screen is enabled in the Extended
menu; see page 58) and as the A/V Mute screen (if you selected
the Logo as the Display Background in the Extended menu).
None of the User’s Logo features can be changed when the User’s
Logo Protect function is enabled.

4. Press Menu to close the Password Protect menu.

If you lose the remote control, you will not be able to enter the
password, so keep the remote control in a safe place at all times.

You can attach the password protect sticker to the projector as an
additional theft deterrent.

Numeric

buttons |

Source
Power Ssearch  Help

Menu A Esc

Vol— Enter/Auto Vol+

ColorMode Aspect

v
+ — Freeze
% A/VMute

~——
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Starting the Projector with a Password

When the password function is enabled, you see this screen when you
turn on the projector:

| Pazzwnrd]

faler the password,

St gour decommntatien for mare anformation.

[ T0-5]:ater

Use the numeric buttons on the remote control to enter the password.
Once you have entered the password correctly, the password screen
closes, and projection begins.

If the password is not correct, you see the message Wrong password.
Please try again. If you enter an incorrect password three times in
succession, you see the message The projector’s operation will be
locked. Request code xxxxx and the projector switches to standby
mode for approximately 5 minutes. Write down the request code.
Then disconnect the projector’s power cord from the electrical outlet,
reconnect it, and turn the projector back on.

When you see the Password Protect Release screen again, you can try
to enter the correct password.

If you enter an incorrect password 30 times in succession, the
projector remains locked and you must contact Epson for service.

If you have forgotten the password, contact Epson with the request
code number that appears in the Password Protect Release screen for
assistance. See “Where To Get Help” on page 87.
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Disabling the Projector’s Buttons

You can use the Operation Lock function to disable all the projector’s
buttons, or all the buttons except for the O Power button.

1.
2.
3.

Press the Menu button.
Select the Settings menu and press Enter.

Use the up and down arrow buttons to select Operation Lock
and press the Enter button.

Select Full Lock to disable all the buttons, or Operation Lock to
disable all except the © Power button. Then press Enter.

Select Yes and press Enter to confirm the setting.

Press the Menu button.

Installing Security Locks
You can install two different types of security locks on the projector:

You can use the security slot on the base of the projector to install
a Kensington Microsaver Security System. See page 13.

You can use a wire lock to secure the projector to a room fixture
or heavy furniture, as shown below:

/_/_/_/_/_/_/_/_7 Y

note

To cancel Operation Lock,
press the projector’s Enter

button for 7 seconds.
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note

The Computer Input (1 and
2), User’s Logo, Lamp
Hours, and Language
settings do not return to
their defaults when you
select Reset All. To reset the
computer inputs, use the
Reset option on the Signal
menu; see page 54 for
details. To reset the
Language settings, use the
Reset option on the
Extended menu; see page 58
for details.

Restoring the Default Settings

The Reset menu lets you return most projector menu settings to their
default values. It also lets you reset the lamp hours to their initial
default value; see page 75 for instructions on resetting the lamp timer.

Reset All
Signal Reset Lamp Hours

[T#T:Select [Enter] :Enter [Menul:Exit |

To reset most projector menu settings, select Reset All and press the
Enter button to display the confirmation screen. Select Yes to reset all
the default settings or No to cancel.
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warning

Before you clean any part of
the projector, turn it off and
unplug the power cord.
Never open any cover on the
projector, except the lamp
and filter covers. Dangerous
electrical voltages in the
projector can injure you
severely. Do not try to service
this product yourself, except
as specifically explained in
this User’s Guide. Refer all
other servicing to qualified
service personnel.

Maintenance and
Transportation

Your projector needs little maintenance. All you need to do on a
regular basis is keep the lens clean. Any dirt or smears on the lens may
show up on your projected image.

You may need to clean the air filter and air vents. A clogged air filter
or air vent can block ventilation needed to cool the projector and
cause overheating.

The only parts you should replace are the lamp and air filter. If any
other part needs replacing, contact your dealer or a qualified servicer.

This chapter covers the following:

Cleaning the lens

m  Cleaning the projector case

m Cleaning and replacing the air filter
m Replacing the lamp

m  Resetting the lamp timer

m  Transporting the projector
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caution
Do not use glass cleaner to
clean the lens.

Cleaning the Lens

Clean the lens whenever you notice dirt or dust on the surface.

To remove dirt or smears on the lens, use a commercially available
cloth for cleaning glasses.

Cleaning the Projector Case

Before you clean the case, first turn off the projector and unplug the
power cord.

m Toremove dirt or dust, wipe the case with a soft, dry, lint-free
cloth.

m Toremove stubborn dirt or stains, moisten a soft cloth with water
and a mild detergent. Then wipe the case.

m Do not use wax, alcohol, benzene, paint thinner, or other
chemical detergents. These can damage the case.

Cleaning and Replacing the Air Filter

Your projector includes an air filter to ensure the best performance. If
dust collects on the air filter or vent on the bottom of the projector,
clean them as described below. Dust clogs prevent proper ventilation
and can cause overheating and damage the projector.

When the filter and vent are clogged, the projector displays the
message The projector is overheating. Make sure nothing is
blocking the air vent, and clean or replace the air filter.
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To clean the air filter and air vent, follow these steps:

1. Turn off the projector, allow it to cool down, and unplug the
power cord.

2. To clean the filter and vent, Epson recommends using a small
vacuum cleaner designed for computers and other office
equipment. If you don’t have one, gently clean them using a very
soft brush (such as an artist’s paintbrush).

You can remove the air filter to clean both sides.

Air filter

If the dirt is difficult to remove or if the filter is torn, replace it.
Contact your dealer or call Epson at (800) 463-7766 to obtain a
new one (part number V13H134A13).

3. If you need to clean or replace the filter, slide it off, as shown.
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note

Air filters contain
polycarbonate, ABS resin,
and polyurethane foam.
Dispose of used air filters
according to local
regulations.

note

You can check to see how
many hours the lamp has
been used. See page 60.

Turn off this product when
not in use to prolong the life
of the projector.

warning

Let the lamp cool before
replacing it. If the lamp
breaks, handle the shards
carefully to avoid injury.

4. Align the new filter and slide it in until it clicks into place.

Replacing the Lamp

The projection lamp typically lasts for about 3000 hours of use
(in high brightness mode) or 4000 hours (in low brightness mode). It
is time to replace the lamp when:

m The projected image gets darker or starts to deteriorate.
m  The-g: lamp light is flashing orange.

m  The message Replace the Lamp appears on the screen when the
lamp comes on. To maintain projector brightness and image
quality, replace the lamp as soon as possible.

Contact your dealer or call Epson at (800) 463-7766 for a
replacement lamp. Request part number V13H010L42.

Follow these steps to replace the lamp:

1. Press the O Power button twice to turn off the projector. When
you hear the projector beep twice, unplug the power cord.

N

If the projector has been on, allow it to cool down for at least an
hour (or until the lamp is cool).
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3. Use the screwdriver included with the replacement lamp or a #2
Phillips-head screwdriver to loosen the screw holding the lamp
cover (the lamp cover is located on top of the projector).

4. Slide the cover out, then lift it off.

5. Use the screwdriver to loosen the two screws holding the lamp in
place. (You can’t remove the screws.)

6. Hold the lamp as shown and pull it straight out. note
The lamp(s) in this
QT , product contain mercury.
Dot remove Please consult your state and

o these screws . .
< <!’ o local regulations regarding
disposal or recycling. Do not

put in the trash.
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caution

Do not touch the glass
portion of the lamp
assembly. Touching the glass
could result in premature
lamp failure.

note

Be sure to seat the lamp fully
and secure the lamp cover. If
the lamp is not properly
installed or the cover is loose,
the lamp will not turn on.

7. Gently insert the new lamp along the guide rail. If it doesn’t fit

easily, make sure it’s facing the correct way. Push the lamp down
firmly where the label PUSH appears.

8. Once the lamp is fully inserted, tighten its screws.

9. Lower the lamp cover into place. (The opening should be almost
covered, and the top of the cover should be flush with the top of
the projector.) Then slide the cover closed and tighten the screw.

10. Reset the lamp timer as described in the next section.
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Resetting the Lamp Timer

You must reset the lamp timer after replacing the lamp to clear the
Replace the Lamp warning message. Follow these steps:
1. Connect the power cable and turn on the projector.

2. Press the Menu button on the remote control or projector and
select the Reset menu. Then press Enter.

Return

Reset All
Reset Lamp Hours

[T#7:Select [Enter]:Enter [Menu]:Exit

3. Select Reset Lamp Hours and press Enter. You see a
confirmation screen.

4. Select Yes and press Enter.

5. Press Esc to return to the main menu or the Menu button to exit

the menu system.

note

Do not reset the lamp timer if
you have not replaced the
lamp. If you do, the Lamp
Hours will not accurately
reflect the number of hours
that the lamp has been used.
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Transporting the Projector

The projector contains many glass and precision parts. If you need to
transport it, please follow these packing guidelines to prevent damage
to the projector:

m  When shipping the projector for repairs, use the original
packaging material if possible. If you do not have the original
packaging, use equivalent materials, placing plenty of cushioning

note _ around the projector.
Epson shall not be liable for

any damage incurred during When transporting the projector as freight or checked luggage,
transportation. first put it in a carrying case, then pack it in a firm box, using
cushioning around the case.

m  When you are hand-carrying the projector, be sure to use a
carrying case.
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Solving Problems

This chapter helps you solve problems with your projector, and tells
you how to contact technical support for problems you can’t solve
yourself. This chapter explains the following:

Using the projector’s on-screen help system

What to do when the projector’s status lights flash
Solving problems with the image or sound
Solving password problems

Solving problems with the remote control

Contacting technical support
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Using On-Screen Help

If the image doesn’t look right or your audio isn’t working, you can
get help by pressing the ? Help button on the projector or remote
control.

1. Press the ? Help button on the remote control or projector. You
see the Help menu.

2. Use the up and down arrow buttons on the projector or remote
control to highlight the problem you want to solve. Then press
the Enter button to view the solution(s).

3. Press Esc to view another topic or press ? Help to exit.

If none of the suggestions solves your problem, see additional
solutions to problems in the following sections.

What To Do When the Lights Flash

The lights on top of the projector indicate the projector’s status and
let you know when a problem occurs.

Power light —@@

Lamp light ==
”\V

Temperature C

light

If the projector is not working correctly, first turn it off and unplug it.
Then plug the power cord back in and turn on the projector. If this
does not solve the problem, check the status lights on top of the
projector and try the solutions recommended in the following table.



Power
light

Lamp
light

Temperature
light

Description

Green

Off

Off

The projector is operating normally.

Flashing
green

Off

Off

The projector is warming up. Wait for the image to appear.

Orange

Off

Off

The projector is in standby or sleep mode. You can unplug
it or press the O Power button to turn it on.

Flashing
orange

Off

Off

The projector is shutting down. Wait for the light to stop
flashing and remain orange before unplugging it.

Red

Off

Flashing
orange

The projector is too hot. Make sure the temperature
surrounding the projector does not exceed 95 °F (35 °C)
and there is plenty of space around and under the projector
for ventilation. Clean the air filter and air vents, if
necessary. See page 70 for instructions.

Red

Off

Red

The projector has overheated and turned itself off. Let it
cool for about five minutes, then turn it back on. Make sure
there is plenty of space around and under the projector for
ventilation. If you are using the projector at an altitude
above 4921 ft (1500 m), turn on High Altitude Mode as the
Operation setting in the Extended menu; see page 58. Also
clean the air filter and air vents; see page 70. If it continues
to overheat, you may need to replace the air filter.

Red

Flashing
red

Off

The lamp is burned out, broken, or not installed correctly;
or the lamp cover is open. Close the cover or replace or
reseat the lamp, if necessary, as described on page 72.
Also clean the air filter and air vents; see page 70. If these
suggestions don’t work, contact Epson.

Orange

Flashing
orange

Off

Replace the lamp with a new one as soon as possible; see
page 72 for instructions. If you continue to use the lamp,
there is a risk it may break.

Red

Off

Flashing red

There is a problem with the fan or a sensor. Clean the air
filter and air vents; see page 70.

If this does not solve the problem, turn the projector off
and unplug it. Contact Epson for help; see page 87.

Red

Red

Red

There is an internal error in the projector. Turn the projector
off and unplug it. Contact Epson for help; see page 87.
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Solving Problems with the Image or
Sound

No image appears on the screen.

Check that the O Power light is green, not flashing, and the
A/V Mute slide is open. Also press the A/V Mute button on the
remote control to see if the picture was turned off temporarily.

If the projector doesn’t turn on, the Operation Lock may be
enabled. Press and hold the Enter button on the projector for
7 seconds to release the lock.

The projector may be in standby or sleep mode. If the projector
has not received any signal for 30 minutes, it turns off the lamp to
conserve the lamp life and save energy. If the O Power light is
orange, press the O Power button to turn on the projector.

The attached computer may also be in sleep mode or displaying a
black screen saver. Try pressing a key on the computer.

If the power was switched off and then on again, wait until the
O Power light stops flashing and remains orange. Then press the
O Power button again.

Check the Video Signal, Computerl Input, or Computer2
Input setting in the Signal menu to make sure it is correct for the
selected source. See page 54 for more information.

Messages may have been turned off in the Display setting of the
Extended menu. See page 58 for details.

Adjust the Brightness setting on the Image menu (see page 53)
or select High for the Brightness Control setting in the Settings
menu (see page 57).

With Direct Power On enabled in the Operation setting of the
Extended menu, if you unplug the projector and then plug it right
back in, you must press the O Power button to turn on the
projector. See page 58 for details.

Make sure at least one of the projector’s remote receivers are
turned on in the Settings menu. See page 56 for details.



Nothing appears on the external monitor.

Make sure the VGA computer cable is connected to your
computer’s video port and the projector’s Computerl port.

Make sure the cable from your monitor is connected to the
projector’s Monitor Out port.

You see a blue screen with the message No Signal displayed.

Make sure the cables are connected correctly, as described in
Chapter 1.

Make sure the power to your computer or video source is
turned on.

If you’ve connected a computer and one or more video sources,
you may need to press the Source Search button on the
projector or the remote control to select the correct source. Allow
a few seconds for the projector to sync up after pressing the
button.

If you've connected a laptop computer, make sure it’s set to
display on an external monitor. See page 36.

The message Not Supported is displayed.

Make sure your computer’s resolution doesn’t exceed UXGA and
the frequency is supported by the projector. See page 93. If
necessary, change your computer’s resolution setting as described
on page 82.

Make sure the correct Video Signal is selected in the Signal
menu. See page 56. It should normally be set to Auto.

The buttons on the projector don’t work.

The Operation Lock may be enabled. Press and hold the Enter button
on the projector for 7 seconds to release the lock.
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Only part of the computer image is displayed.

If you're projecting from a computer or RGB video device, press
the Enter/Auto button on the remote control. If this doesn’t
work, you may need to adjust the Position setting in the Signal
menu. See page 55 for more information.

If you've enlarged part of the image using the E-Zoom button on
the remote control, press the Esc button to cancel zooming and
return to full display.

Try pressing the Aspect button on the remote control to select a
different aspect ratio (4:3, 16:9, or another available setting).

Make sure your computer’s resolution setting is correct and dual
display is not activated. Ideally, it should be 1024 x 768 to match
the projector’s native resolution. If this option isn’t available,
select another compatible video format. See page 93.

m  Windows:
Right-click the desktop, select Properties, click the Settings
tab, and select a different resolution.

m  Macintosh OS X:
On the Apple menu, choose System Preferences, then
click Display or Displays. Select a different resolution.

You also may need to modify existing presentation files if you
created them for a different resolution. See your software
documentation for specific information.

The image isn’t rectangular, but trapezoid-shaped.

Make sure the projector isn’t placed off to one side of the screen,
at an angle, or the image won’t be rectangular. Place it directly in
front of the center of the screen, facing the screen squarely.

If you've tilted the projector upward, the image will be broader at
the top. Turn on Auto Keystone as described on page 56 or hold
down the 7% or \_/ buttons on top of the projector until the
image is rectangular.



The image contains static or noise.

m If you're using a computer cable longer than 6 feet (2 meters), or
an extension cable, the image quality may be reduced.

m  Keep your computer and video cables separated from the power
cord as much as possible to prevent interference.

m The video signal may be split between the computer and the
projector. If you notice a decline in the projected image quality
when the image is displayed simultaneously on your laptop
computer and the projector, turn off the laptop’s LCD display.

m If you're projecting from a composite or S-Video source, check
the Video Signal setting in the Signal menu. In most cases, leave
it set at Auto. If you're using a 60-Hz PAL video source, change
this setting to PAL60. See page 56 for details.

m  Make sure the cables are securely connected at both ends.

m  Select the correct resolution; see “Compatible Video Formats” on
page 92.

m If you're projecting from a computer, press the Enter/Auto
button on the remote control or the Enter button on the
projector to adjust tracking and sync automatically. If that doesn’t
work, try adjusting the Sync and Tracking settings in the Signal
menu. See page 55.

The image is blurry.
m  Adjust the focus using the focus ring. See page 38.
m Try cleaning the lens as described on page 70.

m  Make sure the lens is not fogged by condensation. You may need
to wait before using the projector after moving it from a cold
environment.

m  Make sure the projection distance is within the range described on
page 16.

m  Adjust the Sharpness setting on the Image menu (see page 54).
You should be able to see the effect on the screen immediately.
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Because of the different
technologies used, your
projected image may not
exactly match the colors on
your laptop or computer
monitor.

84  Solving Problems

You see vertical stripes or the image still looks blurry after
trying the solutions in the previous section.

If you're projecting from a computer and displaying an image that
contains a lot of fine detail, you may notice one or more vertical
stripes or bands, or some of the characters may look heavy or
blurred. Press the Enter/Auto button on the remote control to
automatically reset the projector’s tracking and sync settings.

If necessary, you can manually adjust the Tracking and Sync
settings on the Signal menu as described on page 55.

To help you adjust these settings, fill the screen with a detailed
image, such as a desktop background pattern or black text on a
white background. Adjust the Tracking setting to eliminate
vertical stripes; adjust the Sync setting to increase the sharpness.

The colors of the image are not right.

Try selecting a different Color Mode. See page 53 for
instructions.

If you're displaying video, adjust the Color Saturation and Tint
settings on the Image menu. See page 53 for instructions.

Adjust the Brightness, Contrast, and Color Adjustment
settings on the Image menu. See page 53.

Make sure the input signal setting on the Signal menu matches
the signal from the connected device. See page 54 for details.

If the image is too purple and you’ve connected a computer or
RGB video device to the Computerl or Computer2 port, select
Computer as the input source. If you’ve connected a component
video device to one of these ports, select Component Video.

If you're projecting from a composite video or S-Video source,
select the correct Video Signal is selected on the Signal menu.

Check your computer display settings to correct the color balance.

If the image seems dark, the lamp may be nearing time for
replacement. Check the lamp hours as described on page 60 and
replace it, if necessary, as described on page 72.



There is no sound.

m  Press the <) button on the projector or the Vol+ button on the
remote control to turn up the volume.

m If you've turned off the picture and sound, press the A/V Mute
button on the remote control to turn them on again.

m Ifyou're using a DVD player or other video source, or external
speakers, make sure their volume is not turned all the way down
or muted. Also, make sure the cables are connected correctly, as
described in Chapter 1.

m  Make sure the audio cable is connected to the correct audio port.
See page 22 or page 29.

m If your presentation includes computer audio, make sure the
volume control on your computer is not turned all the way down
or muted. Make sure the audio cable is securely connected to both
the projector and your computer. See page 22.

m The wrong source may be selected. Press the Source Search
button on the projector or the remote control.

Solving Password Problems

You have forgotten the password.

m  Write down the request code that appears in the Password Protect
Release screen and contact Epson. See page 87.

m If you turned on the password protect feature before setting the
password and no password was set before, try using the default
password: 0000.

The remote control is not available.

You must have the remote control to enter the password. You can
purchase a replacement remote control from Epson. See page 88.
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Solving Problems with the Remote
Control

The projector doesn’t respond to remote control commands.

Make sure you are within 20 feet of the projector, and within
range of the projector’s front or back sensor (approximately 30° to
the left or right and 15° above or below).

If a button on the remote control is held for more than 30
seconds, the remote enter sleep mode. Press another button for
normal operation.

The remote control batteries may not be installed correctly or may
be low on power. Replace the batteries as described on page 48.

Dim the room lights and turn off any fluorescent lights. Make
sure the projector is not in direct sunlight. Strong lighting,
especially fluorescent lights, may affect the projector’s infrared
receivers. If you still have trouble using the remote control, disable
one of the remote receivers using the Settings menu to block
interference from bright light. See page 56 for details.

Turn off any nearby equipment that emits infrared energy, such
as a radiant room heater.

You have lost the remote control.

You need the remote control to access many projector features. If you
have lost it, you can order another from Epson. See page 88 for
details.



Where To Get Help

Epson provides these technical support services:

Internet Support

Visit Epson’s support website for solutions to common problems with
the PowerLite 83V+. You can download utilities and documentation,

get FAQs and troubleshooting advice, or e-mail Epson with your
questions.

Speak to a Support Representative
To use the Epson PrivateLine Support service, call (800) 637-7661

and enter the PIN on the included Epson PrivateLine Support card.
This is the fastest way of speaking to a live representative, and it’s free.
This service is available 6 AM to 6 PM, Pacific Time, Monday through

Friday, for the duration of your warranty period.

You may also speak with a projector support specialist by dialing one

of these numbers:

Days and hours of support are subject to change without notice. Toll

U.S.: (562) 276-4394, 6 AM to 6 PM, Pacific Time, Monday
through Friday

Canada: (905) 709-3839, 6 AM to 6 PMm, Pacific Time, Monday

through Friday

or long distance charges may apply.

Before you call, please have the following information ready:

Product name (PowerLite 83V+)
Product serial number (located on the bottom of the projector)
Proof of purchase (such as a store receipt) and date of purchase
Computer or video configuration

Description of the problem

Solving Problems
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Purchase Supplies and Accessories

You can purchase screens, carrying cases, or other accessories from an
Epson authorized reseller. To find the nearest reseller, call
800-GO-EPSON (800-463-7766). Or you can purchase online at
www.epsonstore.com (U.S. sales) or www.epson.ca (Canadian sales).
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Technical Specifications

General

Type of display
Lens

Resolution

Color reproduction

Light output
(brightness)

Contrast ratio

Image size

Projection distance
Projection methods
Focus adjustment
Zoom adjustment
Internal sound system
Optical aspect ratio

Zoom ratio

Poly-silicon TFT active matrix
F=1.6t01.74,18.4t0 22.12 mm
1024 x 768 pixels (XGA)

Full color, 16.77 million colors

High brightness mode
White light output 2200 lumens (ISO
21118 standard)
Color light output 2200 lumens

Low brightness mode
White light output 1760 lumens (ISO
21118 standard)

400:1

30 to 300 inches (0.8 to 7.6 meters)
2.7 to 34 feet (0.9 to 10.4 meters)
Front, rear, ceiling

Manual

Manual

10 W monaural

4.3 (horizontal:vertical)

1:1.2 (optical)
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Lamp life will vary
depending upon mode
selected, environmental
conditions and usage.
Brightness decreases over
time.
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Noise level

Keystone correction
angle

Projection Lamp
Power consumption

Lamp life

Remote Control
Range

Batteries (2)

Dimensions
Height (including feet)
Width

Depth

Weight

Electrical
Rated frequency

Power supply

Power consumption

35 dB (High brightness mode)
28 dB (Low brightness mode)

+ 30° vertical (maximum)

170 W UHE

About 3000 hours (High brightness);
4000 hours (Low brightness)

20 feet (6 meters)
Alkaline AA

4.3 inches (108 mm)
12.9 inches (327 mm)
9.6 inches (245 mm)
6.4 1b (2.9 kg)

50/60 Hz

100 to 120 VAC, 2.8 A
220t0 240 VAC, 1.2 A
Operating: 248 W
Standby: 4.1 W



Environmental
Temperature

Humidity

Altitude

Operating: 41 to 95 °F (5 to 35 °C)
Storage: 14 to 140 °F (-10 to 60 °C)

Operating: 20 to 80% RH,
non-condensing

Storage: 10 to 90% RH,
non-condensing

Up to 4,900 feet (1,500 m)
Up to 7,500 feet (2,286 m) with High
Altitude Mode enabled; see page 58

Safety and Approvals

United States

Canada

pixelworks”

FCC Part15B Class B (DoC)
UL60950-1

ICES-003 Class B
CSA C22.2 No. 60950-1

Pixelworks™ DNX™ ICs are used in this
projector.

Technical Specifications
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Compatible Video Formats

You can use any of the following video sources: VCR, DVD player,
camcorder, digital camera, or gaming console. The projector supports
composite video, S-Video, component video, and RGB video, and it
automatically senses the video format (HDTV, SDTV, NTSC, PAL,
or SECAM).

The projector supports these international video standards:

Mode Refresh Rate (Hz)
NTSC 60
NTSC 4:3 60
PAL 50
M-PAL 60
N-PAL 50
PAL60 60
SECAM 50
TV525i 60
TV625i 50
SDTV (480p and 480i) 60
SDTV (576p and 576i) 50
HDTV720p 60
HDTV720p 50
HDTV1080i 60
HDTV1080i 50




Compatible Computer Display Formats

You can connect the projector to a wide range of computers, including
PCs and notebooks, Apple Macintosh, PowerPC and Intel Core
Macintosh computers, PowerBook computers, many iMac and iBook
series systems, and high-end workstations such as the Sun®
SPARCstation.™

Although images are displayed at the projector’s native resolution of
1024 x 768 pixels, Epson’s patented SizeWise chip supports computer
display formats ranging from VGA through UXGA.

To project images output from a computer, the computer’s external
monitor signal must be set at a refresh rate (vertical frequency) that’s
compatible with the projector; see the following table for compatible
formats. For best results, the computer’s resolution should be set to
match the projector’s native resolution (1024 x 768). If this resolution
isn’t available, select one of the other compatible formats:

m  Windows:
Right-click the desktop, select Properties, click the Settings tab,
and select a compatible resolution. (For a notebook displaying
through an external monitor port, you’ll need to click the
Advanced button on the Settings tab, then adjust the resolution
of the external monitor.)

m  Macintosh OS X:
From the Apple menu, select System Preferences, then click
Display or Displays. Make sure the VGA Display or Color LCD
dialog box is selected, then click the Display tab and select a
compatible resolution.

You may need to modify existing presentation files if you created them

for a different resolution. See your software documentation for details.

Technical Specifications
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The projector supports these monitor display formats:

Mode Refresh Rate (Hz) Resolution
VGA EGA 70 640 x 350
VGA—60 60 640 x 480
VESA—72 72 640 x 480
VESA—T75 75 640 x 480
VESA—85 85 640 x 480
VGA—120 120 640 x 480
SVGA—56 56 800 x 600
SVGA—60 60 800 x 600
SVGA—72 72 800 x 600
SVGA—T75 75 800 x 600
SVGA—85 85 800 x 600
SVGA—120 120 800 x 600
XGA—60 60 1024 x 768
XGA—T70 70 1024 x 768
XGA—T75 75 1024 x 768
XGA—85 85 1024 x 768
XGA—120 120 1024 x 768
SXGA1—70 70 1152 x 864
SXGA1—75 75 1152 x 864
SXGA1—85 85 1152 x 864
SXGA1—100 120 1024 x 768
SXGA2—60 60 1280 x 960
SXGA2—75 75 1280 x 960
SXGA2—85 85 1280 x 960
SXGA3—60 60 1280 x 1024
SXGA3—75 75 1280 x 1024
SXGA3—85 85 1280 x 1024
SXGA+—60 60 1400 x 1050
SXGA+—T75 75 1400 x 1050
SXGA+—85 85 1400 x 1050
UXGA—60 60 1600 x 1200
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Mode Refresh Rate (Hz) Resolution
iIMAC VGA 117 640 x 480
iIMAC SVGA 95 800 x 600
iIMAC XGA 75 1024 x 768
MAC13 67 640 x 480
MAC16 75 832 x 624
MAC19—60 59 1024 x 768
MAC19 75 1024 x 768
MAC21 75 1152 x 870
SDTV 480i 60 720 % 480
SDTV (576i) 50 720 x 576
SDTV (480p) 60 720 x 480
SDTV (576p) 50 720 x 576
HDTV (720p) 50/60 1280 x 720
HDTV (1080i) 50/60 1920 x 1080
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Notices

This chapter includes safety instructions and other important information
about your PowerL.ite projector.

Important Safety Instructions

Follow these safety instructions when setting up and using the projector:

m Do not place the projector on an unstable cart, stand, or table.
m Do not use the projector near water or sources of heat.

m  Use the type of power source indicated on the projector. If you are not
sure of the power available, consult your dealer or power company.

m  Place the projector near a wall outlet where the plug can be easily
unplugged.

m Insert the projector’s two-prong plug into a properly grounded outlet.
Do not hold the plug with wet hands.

m  Take the following precautions for the plug. Failure to comply with
these precautions could result in sparks or fire: Do not insert the plug
into an outlet with dust present. Insert the plug firmly into the outlet.

m Do not overload wall outlets, extension cords, or integral convenience
receptacles. This can cause fire or electric shock.

m Do not place the projector where the cord can be walked on. This may
result in fraying or damage to the plug.

m  Unplug the projector from the wall outlet before cleaning. Use a damp
cloth for cleaning. Do not use liquid or aerosol cleaners.

m Do not block the slots and openings in the projector case. They provide
ventilation and prevent the projector from overheating. Do not operate
the projector on a sofa, rug, or other soft surface, or in a closed-in
cabinet unless proper ventilation is provided.

m  Never push objects of any kind through the cabinet slots. Never spill
liquid of any kind into the projector.
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m  Except as specifically explained in this User's Guide, do not attempt to
service this product yourself. Refer all servicing to qualified personnel.
Opening or removing covers may expose you to dangerous voltages and
other hazards.

m  Unplug the projector from the wall outlet and refer servicing to qualified
service personnel under the following conditions: When the power cord
or plug is damaged or frayed. If liquid has been spilled into the
projector, or if it has been exposed to rain or water. If it does not operate
normally when you follow the operating instructions, or if it exhibits a
distinct change in performance, indicating a need for service. If it has
been dropped or the housing has been damaged.

[ The lamp(s) in this product contain mercury. Please consult your
state and local regulations regarding disposal or recycling. Do not put
in the trash.

m  Unplug the projector during lightning storms or when it will not be used
for extended periods.

m Do not place the projector and/or remote control on top of
heat-producing equipment or in a hot location.

m If you use the projector in a country other than where you purchased it,
use the correct power cord for that country.

m Do not stand on the projector or place heavy objects on it.

m Do not use the projector outside of the required temperature range of
4110 95 °F (5 to 35 °C). Doing so may cause an unstable display and
could lead to projector damage.

m Do not store the projector outside of the required temperature range of
14 to 140 °F (-10 to 60 °C) or in direct sunlight for long periods of
time. Doing so may cause damage to the case.

WARNING: The cords included with this product contain chemicals,
including lead, known to the State of California to cause birth defects or
other reproductive harm. Wash hands after handling. (This notice is
provided in accordance with Proposition 65 in Cal. Health & Safety Code §
25249.5 and following.)



FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a
Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are
designed to provide reasonable protection against harmful interference in a
residential installation. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the
instructions, may cause harmful interference to radio or television reception.
However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause interference to radio and television
reception, which can be determined by turning the equipment off and on,
the user is encouraged to try to correct the interference by one or more of the
following measures:

m  Reorient or relocate the receiving antenna.
m Increase the separation between the equipment and receiver.

m  Connect the equipment into an outlet on a circuit different from that to
which the receiver is connected.

m  Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this
equipment will invalidate the FCC Certification or Declaration of this device
and may cause interference levels which exceed the limits established by the
FCC for this equipment. It is the responsibility of the user to obtain and use
a shielded equipment interface cable with this device. If this equipment has
more than one interface connector, do not leave cables connected to unused
interfaces. Changes or modifications not expressly approved by the
manufacturer could void the user’s authority to operate the equipment.

For Canadian Users

This Class B digital apparatus meets all requirements of the Canadian
Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Reglement
sur le materiel brouilleur du Canada.

Notices
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Index

A/V cable, 24 to 25

A/V Mute, 46, 59, 63 to 64, 80, 85

Accessories, 13, 88

Air filter
cleaning and replacing, 70 to 72
purchasing, 13

Altitude, 59, 91

Anti-theft device, 13

Aspect button, 47

Aspect ratio, 47, 56, 89

Aspect setting, 56

Audio
adjusting volume, 41, 57
cable, 22, 85
connecting laptop, 22
problems, troubleshooting, 85
turning off, 46

Auto button, 41, 55

Auto Keystone correction, 17, 40, 50, 57

Auto Setup setting, 41, 55

Background Color setting, 59, 65
Banding in image, 84

Batteries, replacing, 48
Blackboard color mode, 45, 53
Blank screen, 36 to 37, 80 to 81
Blue background, 59

Blurry image, 83

Brightness, 72, 89

Brightness Control setting, 40, 80
Brightness setting, 40, 53, 80, 84
Buttons, disabling projector, 57, 67

Cables, 10 to 13, 88
Camcorder, connecting to, 24 to 31

Carrying case, optional, 76
Ceiling
mount, 17
projection, 17, 59
Cleaning
air filter and vents, 70 to 72
lens, 70
projector case, 70
Color
adjusting, 45, 52 to 54
problems, 84
specifications, 89
Color Adjustment setting, 54
Color Mode, 45, 53
Color Saturation setting, 53
Component-to-VGA video cable, 12 to 13, 24,
28
Composite video cable, 24 to 25
Computer
cable, 10, 18 to 20
connecting to projector, 18 to 22
source, selecting, 19, 20, 36, 44, 55
support, 7
supported display formats, 93 to 95
Computer/Component Video ports, 19 to 20,
27,44
Connecting projector
to a computer, 18 to 22
to a game console, 24 to 31
to a video source, 24 to 31
to external monitor, 21
to speakers, 23, 31
Contrast, 89
Contrast setting, 53, 84

Default password, 62

Default settings, restoring, 68

Digital camera, connecting to, 24 to 31
Dimensions, 90

Index
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Direct Power On setting, 59 iMac, connecting to, 12, 18 to 20

Distance from projector to screen, 16, 89 Image
Documentation, using, 9 capturing and saving in projector, 63 to 64
DVD player, connecting to, 24 to 31 correcting shape of, 40, 57, 82
fitting on screen, 41, 55, 56, 82
focusing, 38
freezing, 46
Entering the password, 66 height, adjusting, 39
Environmental specifications, 91 menu, 50, 52 to 54
Epson positioning, 39, 41, 55
accessories, 13, 88 problems, 80 to 84
PrivateLine Support, 9, 87 raising, 39
Store, 88 selecting source, 19, 20, 25, 35, 36, 44,
technical support, 9, 87 55 to 56
warranty, 10 shape, correcting, 40, 57, 82
Extended menu, 50, 58 to 59 size and projection distance, 16, 89
External monitor, connecting, 21 turning off, 46
E-Zoom button, 47 zooming, 47

Info menu, 50, 60 to 61
Input signal, selecting, 19, 20, 25 to 28, 36,
44, 55 to 56

FCC compliance statement, 99 Instant OFf feature, 42
Filter, cleaning and replacing, 70 to 72
Focusing, 38
Foot release lever, 39
Freeze button, 46 Kensington anti-theft device, 13
Front projection, 16 to 17, 59 Keystone correction, 40, 57, 82, 90
Front/Ceiling setting, 17, 59
Full Lock setting, 57, 67
Lamp

automatic shutoff, 42
Game color mode, 45, 53 brightness, 72, 80, 89
Game console, connecting to, 24 to 31 number of hours used, 60, 72, 75, 90

replacing, 72 to 75
specifications, 90

. . _— status light, 78 to 79
Height of image, adjusting, 39 timer, resetting, 75

Help, 9,87 Language setting, 59

Help system, using, 78 Laptop computer

High Altitude Mode setting, 59, 91 connecting to, 18 to 20
High brightness, 40, 72, 80, 89 displaying on, 36 to 37, 81

LCD panels, 7

iBook, connecting to, 18 to 19
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Lens

cleaning, 70
specifications, 89 Password
Lights, status, 78 to 79 default, 62
Logo entering, 66
creating, 63 to 64 logo protection, 63 to 66
displaying, 64 to 65 problems, 85
turning on, 59, 65 prompt, 35, 66
Low brightness, 40, 72, 89 request code, 66
setting, 64 to 65
turning on, 65
Photo color mode, 45, 53
Macintosh Picture source, selecting, 19, 20, 25 to 28, 36,
connecting, 18 to 20 55 to 56
Macintosh display problems, 37 Pixelworks, 91
Manuals, 9 Position setting, 55
Menus Positioning
changing settings, 51 to 52 image, 39, 55
Extended, 50, 58 to 59 projector, 16 to 17
Image, 50, 52 to 54 Power
Info, 50, 60 to 61 button, 35, 42
Reset, 50, 68 consumption, 90
Settings, 50, 56 to 57 light, 35, 78 to 79
Signal, 50, 54 to 56 supply, 90
User’s Logo, 63 to 64 PowerBook, connecting to, 18 to 20
using, 50 to 52 Presentation color mode, 45, 53
Messages setting, 58 PrivateLine Support, 9, 87
Monitor, external, 21 Problems
Moving projector, 76 color, 84
image, 80 to 84
no signal, 36 to 37
password, 85
No Signal message, 36 to 37 remote control, 86
Noise level, 90 sound, 85

Projection lamp, see Lamp

Operation Lock setting, 57, 67
Options for projector, 13, 88
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Projector
accessories, 13, 88
carrying case, optional, 76
cleaning, 69 to 72
disabling buttons, 57, 67
distance from screen, 16, 89
foot, adjusting height with, 39
lamp specifications, 90
password protection, 61 to 66
positioning, 16 to 17
resolution, 7, 89, 93 to 95
transporting, 76
turning off, 42
turning on, 34 to 35
unpacking, 10
viewing information about, 60 to 61

Quick Setup sheet, 9

Raising image, 39
RCA A/V cable, 24 to 25
Rear projection, 17, 59
Registration, 10
Remote control
problems, 86
receivers, disabling, 57, 80, 86
replacing batteries, 48
specifications, 90
using, 43 to 48
Remote Receiver setting, 57, 80, 86
Replacing
air filter, 70 to 72
lamp, 72 to 75
remote control batteries, 48
Request code, password, 66
Reset menu, 50, 68
Resolution, 7, 60, 89, 93 to 95

Index

Safety

approvals, 91

instructions, 97 to 98
Screen logo, see User’s Logo
Screen, distance from projector, 16, 89
Screens, portable, 13
Setting a password, 64 to 65
Settings menu, 50, 56 to 57
Sharpness setting, 54
Signal menu, 50, 54 to 56
Sleep mode, 42, 59
Sound, see Audio
Source Search button, 19 to 20, 25 to 28,

3510 36, 44

Speaker, specifications, 89
Speakers, connecting external, 23, 31
Specifications, technical, 89 to 95
Sports color mode, 45, 53
SRGB color mode, 45, 53
Startup screen

creating, 63 to 64

displaying, 64 to 65

user’s logo, see User’s Logo
Startup Screen setting, 59
Status lights, 78 to 79
Stopping action, 46
Stripes in image, 84
Support, 9, 87
S-Video cable, 12, 13, 24
Switching picture source, 36, 44
Sync, adjusting, 55, 83 to 84

Technical support, 9, 87
Temperature
light, 78 to 79
requirements, 91
Test Pattern setting, 57
Text color mode, 45
Theatre color mode, 45, 53
Timer, lamp, 75
Tint setting, 54



Tracking, adjusting, 55, 83 to 84 Warranty, 10, 10

Transporting projector, 76 Weight, 90
Troubleshooting
color, 84
cut-off image, 41, 82
image quality, 83 to 84 Zoom ratio, 89
image shape, 82 Zooming image, 47

no image, 80 to 81

no signal, 36 to 37

no sound, 85

password, 85

remote control problems, 86
Turning off

audio, 46

picture, 46

projector, 42
Turning on

password, 65

projector, 34 to 35

User’s Logo, 59, 65
Typing the password, 66

Unpacking projector, 10
User’s Logo
creating, 63 to 64
displaying, 64 to 65
turning on, 59, 65

VCR, connecting to, 24
VGA computer cables, 10, 18 to 20
Video
display settings, 60 to 61
formats, supported, 7, 92
source, connecting to, 24 to 31
source, selecting, 25, 35 to 36, 44, 55 to 56
Video Signal setting, 56
Volume, adjusting, 41, 57

Warning lights, 78 to 79
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